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DeskPictRotator Pro

Introduction

Thank you for trying DeskPictRotator Pro! This product is an evolution of our AppleScript called
DeskPictRotater (we corrected the spelling!), which has had thousands of downloads (you know who
you are, and thanks!). Many users asked for features, such as a more friendly interface (customizing
DeskPictRotater meant editing the script), and the ability to choose screen positioning on a picture
basis. We listened, and here it is!

What Is It?

DeskPictRotator Pro is a Macintosh application which allows the user to define a set of pictures that
will be used to periodically set the desktop picture. Working with the MacOS Appearance control
panel, it offers these features:

• A sortable list of pictures, including thumbnail representations, file name, and screen positioning
(such as centered or tiled).

• Screen positioning set on a picture basis.

• Drag-and-drop support for adding pictures (files or folders) to the list.

• Simple picture list management.

• Selectable change interval, in seconds, minutes, hours, or days.

• Scheduling features, where you can choose the time during which pictures will be changed, with
the option to treat weekends differently from weekdays.

• Change the pictures randomly or in order (based on sort order in the main window).

• Ability to change the picture immediately, or to set a specific picture.

• Each picture can be located on any disk or in any folder.

• Flexible picture preview generation, either automatic or manual.

• Ability to stop changing pictures without quitting the program.
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• Internet link to find desktop pictures.

• Multiple-monitor support (limited).

• Balloon Help.

Features are discussed in more detail below.

What Do I Need?

MacOS 8.5 or higher.
Approximately 2.5 MB free RAM.
Approximately 2 MB free disk space, plus space for the pictures you want to use.
A color monitor displaying at least thousands (16-bit) of colors is recommended.

Registration

DeskPictRotator Pro is distributed as shareware.

Shareware is a method of distributing software so that users can "try before buying." When you buy
software at a store, there's typically no recourse if it doesn't meet your needs. With shareware, you
can try the software out for a period, often 30 days, and then decide whether to register and pay for
the product, or stop using it. During the trial period, the software may be fully functional, or have
some features restricted in a "demonstration mode." This depends on how the author sets it up.

DeskPictRotator Pro has a reminder mechanism. The program remains fully functional, but after a
trial period, you will be reminded to register each time you launch the program, or once per day, if
the program remains running.

Shareware is often developed by an individual or a small team, so you can usually get in touch
directly with the author(s) for questions and comments. This can be a tremendous advantage.
Shareware is generally distributed over the Internet or through user groups, with online manuals.

Sounds Good, But Why Should I Register?

Because you like the software! We love the Mac, and want to develop more software to make Mac use
more productive and fun. To do this, though, we need to make money (Sorry, but it's true! Those
banks and utility companies are so picky about being paid! <grin>). We try to keep prices very
reasonable, and hope you find our products a good value.

If you decide you don't want to register, please let us know why. If there's something you'd like to
see, or some feature you need, please let us know.

Whether you decide to register or not, please consider letting a friend know about the software. Word
of mouth can be the best advertising. Thanks!
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What's So Great About Sleeping Cat Software?

Well, maybe we're not great, but we're trying!

We are focused on Macintosh development. There won't be any cross-platform compromises here,
and this is not intended as a springboard for development on other platforms. Development is done
on Macs, for Macs.

Installation

DeskPictRotator Pro is an application, so you may store its folder wherever is convenient for you.
You may wish to make an alias to the application and place it in the Startup Items folder so
DeskPictRotator Pro runs at each startup. To do this, click once on DeskPictRotator Pro's icon to select
it, and choose Make Alias from the Finder's File menu. You will see a second icon appear with its
name in italics; this is an alias. Select this alias icon and drag it to the Startup Items folder:

  The Startup Items folder has the icon to the left, and is located in your Mac's System Folder.
Items in this folder are opened by the Finder when the Mac starts up.

Upgrading from DeskPictRotater

If you have been using DeskPictRotater, upgrading to DeskPictRotator Pro is easy. You probably
have a folder of pictures you have been using with DeskPictRotater, so once you have gotten
DeskPictRotator Pro running and configured its preferences, you should be able to simply drag the
picture folder to DeskPictRotator Pro's window and begin enjoying the new interface.

Getting Started

Start DeskPictRotator Pro by double-clicking its icon. You may wish to explore the menus, then turn
on Balloon Help and explore the main window as well as the Preferences dialog to get a feel for the
program's features.

Then, you need some pictures that you'd like to display on your desktop. Apple supplies some
pictures on the MacOS CD, located in a folder called Sample Desktop Pictures. If you would like to
use some of those, you should copy the pictures to your hard disk, so they'll remain available even
when the CD is put away. There are also many sites on the Internet which have pictures available for
download. DeskPictRotator Pro has a link to a page at Sleeping Cat Software that catalogs some sites
for desktop pictures (see the Internet menu, pictured below). You can probably find others using the
Sherlock search engine included with MacOS.
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Once you have collected some pictures you'd like to use, you must add these to DeskPictRotator Pro's
picture list. You can do this in one of three ways:

• Use the traditional Open command in DeskPictRotator Pro's File menu.

• Select a group of pictures in the Finder, and drag the selection to the picture list in
DeskPictRotator Pro's main window. The list control should highlight. If it does not highlight,
there is at least one unusable picture in the group. Try dragging a few pictures at a time until you
locate the inappropriate file.

• Select a group of pictures in the Finder, and drag the selection to DeskPictRotator Pro's
program icon. The icon should highlight. If it does not highlight, there is at least one unusable
picture in the group. Try dragging a few pictures at a time until you locate the inappropriate file.

http://www.sleepingcatsoftware.com/


DeskPictRotator Pro Reference Copyright © 2000, 2001 Sleeping Cat Software
Page 5 of 15 http://www.sleepingcatsoftware.com/

A word on picture formats: DeskPictRotator Pro provides a friendly, flexible front end for the
desktop picture feature of the Appearance control panel. In fact, DeskPictRotator Pro will start the
Appearance control panel, because it "talks" to it (using Apple Events) to set and position the desktop
picture. DeskPictRotator Pro is limited in the file formats it can use by what Appearance accepts. The
supported formats are GIF, JPEG, TIFF, and PICT. If you have downloaded such files from the
Internet, they would typically have file name extensions such as .jpg, .jpeg, .gif, .tif, .tiff, or .pict.

Once you've added pictures, you can set each picture's positioning on the desktop. The default
positioning for each newly added picture is set in DeskPictRotator Pro's Preferences. To change a
picture's positioning, select it in the list, and use the popup menu in the lower left of the main
window. Each picture's positioning is shown in the rightmost column of the picture list. When you
select a picture, you can see its dimensions in pixels (see the picture below for an example). Using this
dimension information along with knowledge of your monitor's settings, you can determine the
optimal positioning for each picture. You can find your Mac monitor's pixel dimensions by checking
the Monitors control panel (located in the Control Panels folder). For example, if you have a picture
that is 640 pixels wide by 480 pixels high, and your monitor is set to 1024 pixels wide by 768 pixels
high, you might want to choose "Centered" as opposed to "Filling Screen" for the positioning because
filling the screen might distort the picture, or make it too grainy. You can experiment;
DeskPictRotator Pro makes it easy!

Balloon Help is implemented in the program's main window and preferences dialog, so you can use
it to learn about features. To use it, turn on Show Balloons from the Help menu (see below), and
position the mouse cursor over something you'd like to learn about.

A Word on Multiple Monitors
DeskPictRotator Pro has rudimentary support for multiple monitor configurations. Only one monitor
will be used to show desktop pictures, but it will be the monitor which contains the program's main
window. So, if you have a secondary monitor on which you'd like to display pictures while using
your main monitor, simply move DeskPictRotator Pro's main window to that secondary monitor. We
hope to improve this support in a future version.
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Running in a Memory-Constrained Environment

So you have a system with a small amount of memory, but you'd still like to run DeskPictRotator
Pro?

DeskPictRotator Pro can run in as little as 900K of memory (of course, you still must allow RAM for
the Appearance control panel, which is used to set pictures). The primary consumer of memory in
DeskPictRotator Pro is the thumbnail picture previews. To save memory, you should turn off
automatic generation of previews. This is done in the Preferences dialog:

Then, you can add and manage your picture list as usual. If you'd like to see previews for individual
pictures, you can select them in the list, and choose Generate Preview from the File menu. You can
clear a generated preview using Clear Preview, also in the File menu.
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Menu Reference

File

Add Picture

Use this command to add pictures to DeskPictRotator Pro's list. Navigation Services is supported.

Save Settings

This command will save current settings to the preferences file. Settings will also be saved when the
program quits, or when the Preferences dialog is accepted. If this item is grayed out, the preferences
have already been saved.

Reveal in Finder

This command will reveal a single selected picture in the Finder. The Finder will be brought
frontmost.

Generate Preview

DeskPictRotator Pro has a global picture preview setting in the Preferences dialog. When it is turned
on, the program will attempt to generate a thumbnail preview for all pictures, including newly added
ones. However, in a low memory situation, previews may not be generated for all pictures. Using the
Generate Preview command in tandem with the Clear Preview command, you can selectively enable
and disable previews on a picture basis, giving more control in low-memory conditions. NOTE:
individually generated previews are not remembered across program invocations.

Note that if you decide to manage previews in this way, you should turn off the global picture
preview setting.

Clear Preview

Clears the thumbnail preview for the currently selected picture(s).

Quit

Quits the program, saving preferences.

Edit

http://www.sleepingcatsoftware.com/


DeskPictRotator Pro Reference Copyright © 2000, 2001 Sleeping Cat Software
Page 8 of 15 http://www.sleepingcatsoftware.com/

Undo, Cut, Copy, Paste, Clear, Select All

The standard editing commands.

Select None

Especially useful when the picture list is active, this command clears any selection.

Preferences

Brings up the Preferences dialog.

Special

Remove Desktop Picture

This will remove the currently set desktop picture.

Internet

Visit the Sleeping Cat Software Home Page

This will launch your Web browser and go to the Sleeping Cat Software site.

Visit our Desktop Pictures Page

This will launch your Web browser and go to our list of sites to download desktop pictures.

Email a Product Suggestion

This will launch your mail program and pre-address a message to our suggestion address.

Email a Product Question

This will launch your mail program and pre-address a message to our support address.

How to Register

This will launch your Web browser and go to our registration page.
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Help

Show Balloons

Use this command to show popup help for DeskPictRotator Pro's user interface.

What Can I Use It For?

The expected use for DeskPictRotator Pro is in a personal environment, where you can use it to
change your desktop at an interval that's right for you. However, DeskPictRotator Pro can also be
used in a presentation mode; for example, in a kiosk. In the preferences, there is a setting for picture
display order, either In Random Order or In Sorted Order. When set to Sorted, pictures are shown in
the order in which they are sorted in the main window (this depends on which criteria you are
sorting by). So, for example, if you had a series of pictures to be shown in order, simply name them in
sort order (such as Picture 001, Picture 002, etc.), sort the main window by name, change the picture
display order to Sorted, set an appropriate interval, and you have an instant presentation! Of course,
any desktop icons and the menu bar will remain visible.

You can also use DeskPictRotator Pro as a sort of "digital picture frame." Perhaps you could set up a
list of family photos, and rotate through them for a cheerful family room display! Just the thing to
complement a colorful iMac!
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Future

We have some ideas for the next version, but we'd love to hear yours! You can send feedback via the
Internet menu in DeskPictRotator Pro.
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Troubleshooting

The most common thing you're likely to run into is a low-memory condition. DeskPictRotator Pro
tries to adapt to low memory conditions by not generating picture previews and by disabling some
functions. To find out how much memory DeskPictRotator Pro has available, you can check the free
memory display along the lower edge of the main window, or you can choose "About
DeskPictRotator Pro" from the Apple menu. In that case, you will see a window like this:

In the upper right, you'll see a field labeled "Free Memory", followed by a number. The number is the
number of kilobytes (1024 bytes) free, along with possibly the text "low!" The text "low!" indicates that
DeskPictRotator Pro has used its reserve, and in this case, certain commands will be disabled. The
reserve is simply a block of memory that DeskPictRotator Pro sets aside at startup, and releases when
memory runs low. When the reserve is released, memory is critically low, and you should do one or
more of: remove some pictures from the list; turn off picture previews (see the Preferences dialog); or
increase the program's memory allocation
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To increase the memory allocation for the program, ensure DeskPictRotator Pro is not running, select
DeskPictRotator Pro's icon in the Finder, and choose Get Info from the Finder's File menu.
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You should see a window like this:

To increase the program's memory allocation, type a larger number in the "Preferred Size" field; you
can experiment to find the best setting, but increasing by 100K at a time is probably a reasonable
starting point. As a rule of thumb, at millions of colors, a preview adds about 14KB to a picture's
memory usage; at thousands of colors, a preview adds about 9KB.

For example, if you have 100 pictures in DeskPictRotator Pro's list, and want to show previews for all
of them at thousands of colors, you should allocate approximately 1600KB.

If you do not see the Memory Requirements fields, be sure to select the Memory item from the
"Show" popup menu near the top of the window (in this picture, it's right below the Sleeping Cat
Software URL).
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Legal Stuff and License

As stated above, DeskPictRotator Pro is distributed as shareware, and is Copyright © 2000, 2001
Sleeping Cat Software.

LICENSE AGREEMENT

Sleeping Cat Software grants a free trial license for use of this Software (DeskPictRotator Pro),
starting from the date of first use, and continuing for the trial period specified in the Software, after
which time the Software must be registered with the appropriate payment (registration fee) and
registration forms. Under no circumstances may the software be used beyond the trial period unless
the previously stated conditions have been satisfied. You must purchase a separate copy of the
software for each computer it is used on, with the exception that a single registration entitles you to
use the software on up to two computers commonly used by you (for example, in the case when you
have a desktop and a laptop computer).

Ownership

Use of this Software is licensed, and ownership of the Software remains with Sleeping Cat Software,
which reserves all rights not expressly granted to you.

Refund of Fee

You agree that the trial period affords sufficient time to evaluate this Software for your needs, and
that the registration fee is non-refundable.

Release of Liability

The Software is provided "as is." You assume full responsibility for evaluating the Software and
determining its suitability for use. Sleeping Cat Software disclaims all other warranties, express or
implied, including, but not limited to, implied warranties of merchantability and fitness for a
particular purpose. In no event will Sleeping Cat Software, or anyone associated with Sleeping Cat
Software, be liable for any damages of any kind arising from the use of, or inability to use, this
Software, even if Sleeping Cat Software has been advised of the possibility of such damages

Use and Distribution

You may use this program on any number of computers, as long as the fee is paid for each instance
once the trial period has expired. You may not resell it for profit. You may not distribute it. If you
represent a user group and would like to include this product in a shareware compilation, please
contact Sleeping Cat Software for permission.

You may not reverse-engineer, modify, or create derivative works based on the Software or any part
of it.

If you give this Software to anyone, the complete Software distribution package, including the
documentation, must be included and unmodified.

Termination
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This License is effective until terminated. You may terminate this License at any time by destroying
the Software and related documentation and all copies thereof in your possession. This License will
terminate immediately without notice from Sleeping Cat Software if you fail to comply with any
provision of this License. Upon termination you must destroy the Software and related
documentation and all copies thereof in your possession.

Controlling Law and        Severability

This License shall be governed by the laws of the United States and the state of New Hampshire. If
for any reason a court of competent jurisdiction finds any provision, or portion thereof, to be
unenforceable, the remainder of this License shall continue in full force and effect.

-- end of license agreement --
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